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コンポーネント一覧 (1)
カ テ ゴ リ コンポーネント バージョン

Call Control

Cisco Unified Communications Manager

Version 12.5.1.12900-115

Locale cm-locale-ja_JP-12.5.1.2100-1

Dial Plan 3-1-10.JP

Cisco TelePresence Video Communication
Server  Expressway(VCS Expressway)

Version X12.5.7

Locale vcs-lang-jp-jp_8.11_amd64.tlp

Cisco TelePresence Video Communication Server(VCS)

Version X12.5.7

Locale vcs-lang-jp-jp_8.11_amd64.tlp

Management 
Connector

8.9-1.0.321331

Call 
Connector

8.8-1.0.5839

Cisco TelePresence Video Communication Server 
Expressway

Version X12.6PreAlpha18

Locale vcs-lang-jp-jp_8.11_amd64.tlp

Applications

Cisco Unified Communications Manager IM and 
Presence  Service

Version 12.5.1.12900-25

Locale ps-locale-ja_JP-12.5.1.2000-1

Cisco Meeting Server Version 2.8

Cisco Meeting Management Version 2.8.0.97
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コンポーネント一覧 (2)
カ テ ゴ リ コンポーネント バージョン

Voice Mail and 
Unified Messaging Cisco Unity Connection

Version 12.5.1.12900-56

Locale uc-locale-ja_JP-12.5.0.1-2000

End Point

Cisco IP Phone 7811/21/41/61/32 12-7-1-0001-393

Cisco IP Phone 8811/41/45/51/61/65 12-7-1-0001-393

Cisco Wireless IP Phone 8821 11-0-5SR2-2

Cisco Unified IP Phone 9951/71 9-4-2SR4-1

Cisco ATA 191 12-0-1SR2-3

SX20 - Cisco TelePresence SX20 Quick Set Version CE9.10.0

SX80 - Cisco TelePresence SX80 Codec Version CE9.10.0

SX10 - Cisco TelePresence SX10 Quick Set Version CE9.10.0

MX200 G2 - Cisco TelePresence MX200 G2 Version CE9.10.0

MX300 G2 - Cisco TelePresence MX300 G2 Version CE9.10.0

Cisco Webex Room Kit Version CE9.10.0

Cisco Webex Room Kit Plus Version CE9.10.0

Cisco Webex Room Kit Plus PTZ Version CE9.10.0
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コンポーネント一覧 (3)
カ テ ゴ リ コンポーネント バージョン

End Point

Cisco Webex Room Kit Pro Version CE9.10.0

Cisco Webex Board 55 Version CE9.10.0

DX70-Cisco Webex DX70 Version CE9.10.0

DX80-Cisco Webex DX80 Version CE9.10.0

IX5000 - Cisco TelePresence IX5000 Version IX9.1.0(4)

Communications  
Infrastructure

ISR Gateways (3945e/3925e/3945/2921) IOS 15.7.3M5

ISR 4451-X / 4351 IOS 16.12.02s

Cisco Unified Border Element for ISR IOS 15.7.3M5

Cisco 3750 PoE Switch 16.6.2

vCenter Server 6.0 & 6.5

MDS Switch M9500 5.2(2 a)

TelePresence

Cisco TelePresence Management Suite - TMS Version 15.10

Cisco TelePresence Management Suite Provisioning 
Extension - TMSPE

Version 1.15.0

MCU 4510, 5310 & 5320 - Cisco TelePresence MCU
Version 4.5(1.89) & 4.5(1.98) 

Locale MCU_4-3_UI_and_audio_JPN.package
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コンポーネント一覧 (4)
カ テ ゴ リ コンポーネント バージョン

TelePresence

Cisco TelePresence Server 7010 Version 4.4(1.28)

Cisco TelePresence Server on Virtual Machine Version 4.4(1.31)

Cisco TelePresence Conductor Version XC4.3.6

Messaging 
Applications

Cisco Jabber for Mac Version 12.8.0.301920

Cisco Jabber for Windows Version 12.8.0

Cisco Jabber for iOS

Version 12.8.0.301920

iPhone 6 12.4(16G77)

iPhone 6S 13.1.3(17A878)

iPhone 7 13.3.1(17D50)

iPhone X 13.3.1(17D50)

iPhone 11 13.3.1(17D50)

iPad Pro 13.3.1(17D50)

iPad Air 13.3.1(17D50)

Apple Watch 6.1.2(17S796)
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コンポーネント一覧 (5)
カ テ ゴ リ コンポーネント バージョン

Messaging 
Applications

Cisco Jabber for Android

Version 12.8.0.301920

Galaxy S6 Android OS 8.1

Galaxy S7 Android OS 8.1

Xperia Z1 Android OS 7.1.1

Xperia Z3 Android OS 7.1.1

Xperia Z3+ Android OS 7.1.1

Nexus 5X Android OS 8.1.0

Nexus 6P Android OS 8.1.0

Sony Watch Android OS 6.0.1

Sony Tab Android OS 6.0.1

Cisco Webex Teams

Version for iOS 4.9(658)
Version for 
Web Client 2.1561.0

Version for 
Android 

4.9(658)

Version for Mac 3.0.14866.0

Version for 
Windows

3.0.14866.0
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コンポーネント一覧 (6)
カ テ ゴ リ コンポーネント バージョン

Messaging 
Applications

Cisco Webex Room OS Version RoomOS 2020-01-10 cdf8762390f

Cisco Webex Meetings for Windows Version 39.11.2.4

Cisco Webex Meetings for iOS Version 39.11.0 (391100.87)

Cisco Webex Meetings for Android Version 39.11.0.239110292

Cisco Webex Meetings for Web Version 39.10.1.11

Cisco Webex Meetings for Mac Version 39.10.6.11

Cisco Meeting App 

Version for 
Windows and Mac

1.11.19

Version for iOS 1.11.18

CMS WebRTC 2.8 (webclient2.163.4124a42f56)

Version for 
Chrome

79.0.3945.117

Version for Firefox 72.0.1

Version for Safari 13.1

Version for Mac 10.14

Version for iOS 13.3
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コンポーネント一覧 (7)
カ テ ゴ リ コンポーネント バージョン

UCS ESXi Host
B-Series Server 6.0,6.5

C-Series Server 6.0,6.5

Client

Operating System

Windows 7-SP1 Windows7-SP1(Japanese)

Windows 8/8.1 Windows8/8.1(Japanese)

Windows 10 Windows 10 (Japanese)

Mac Book Air 10.14.6

Mac Book Pro 10.14

Browser

IE 11.1246.17134.0 (Supported Japanese 
Language)

Mozilla Firefox 72.0.2(Supported Japanese Language)

Chrome
79.0.3945.130(Supported Japanese 
language)

Safari-iOS, 
Safari- Mac 

13.0.4 (13608.4.9.1.4)

Microsoft Edge 42.17134.1098.0

Cisco Meeting Server WebRTC
Chrome, IE,
Firefox 2.8 (webclient2.163.4124a42f56)

Microsoft Skype for Business Client Version 2016
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コンポーネント一覧 (8)
カ テ ゴ リ コンポーネント バージョン

Server

Microsoft Windows Server

Windows Server2012 R2 (Standard, 
Enterprise,Datacenter - Japanese)

Windows Server 2016 (Datacenter –
Japanese)

Windows Server 2019 (Standard, 
Enterprise, Datacenter, Japanese)

Microsoft Skype for Business Server 2019

Microsoft Exchange Server 2013, 2016 & 2019



テストトポロジ

© 2020 Cisco and/or its affiliates. All rights reserved.CiscoConfidential



© 2020 Cisco and/or its affiliates. All rights reserved.CiscoConfidential

テスト結果

対象コンポーネント テスト項目数 合格数 不合格数 不具合数

CSR 12.7 Solution Testing Components

Cisco Unified Communications Manager 30 30 0 0

Cisco TelePresence Video Communication Server (VCS) 124 112 12 12

Cisco Jabber Clients 69 64 5 5

Cisco Webex Teams 43 43 0 0

Cisco Webex Room OS 84 81 3 3

Cisco Webex Meetings 59 56 3 3

Cisco Meeting Server 68 68 0 0

Cisco TelePresence Multipoint Control Unit 37 37 0 0

Cisco TelePresence Management Suite 22 22 0 0

Cisco TelePresence Conductor 12 12 0 0

Cisco TelePresence Server 14 13 1 1

Cisco TelePresence IX5000 25 25 0 0

Total 587 563 24 24
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Open Caveats (1)

DDTS ID タイトル Se verity 製品

機能 /

コンポーネント ステータス

Cisco TelePresence Video Communication Server

CSCvs42919
Keyboard "Enter" key should be highlight during 

ethernet setting in Webex Room Kit Plus
2 tc-software gui-home O-Opened

CSCvr46860
Name of the endpoint is changing automatically 

during edit and call from SX20 Quick Set
3 tc-software gui-home O-Opened

CSCvr60313
Participant(s) in stageview still clickable when 

covered by full-screen selfview
3 tc-software gui-incall O-Opened

CSCvr60327

Web UI redirects back to signin page with white 

background if "next" parameter is 

/web/signin/random

3 tc-software web-ui O-Opened

CSCvr61379
During call hold, DN label is highlighted in OSD of 

SX20 Quick Set
3 tc-software gui-incall O-Opened
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Open Caveats (2)

DDTS ID タイトル Se verity 製品

機能 /

コンポーネント ステータス

Cisco TelePresence Video Communication Server

CSCvs62346

Remote control OSD fades out when opening 

layout list/participant list when having fullscreen 

selfview

3 tc-software gui-home O-Opened

CSCvr50804

Show passphrase available in English while 

registering into VCS from Webex DX70 under 

Japanese

3 tc-software language O-Opened

CSCvr60354
Add call option is not available in Proximity app 

while connected to Webex DX70
3 tc-software proximity O-Opened

CSCvs52874

Overlap of Hold icon and maximized selfview 

avatar during multisite conference in Touch 10 of 

MX200

3 tc-software gui-incall O-Opened



Open Caveats (3)

DDTS ID タイトル Se verity 製品

機能 /

コンポーネント ステー タス

Cisco TelePresence Server

CSCvr50559
Entering Wrong Credentials Event not included in 

Event Logs of TelePresence Server
2 tc-software application N-New

Cisco Webex  Meetings

CSCvs38297 Webex Meetings username is displaying partially 

incorrect
3 train pt N-New

CSCvr39201

Become Presenter option is wrongly displayed 

when changing presenter role during Webex 

Meeting

3 train mc-macclient A-Assigned

© 2020 Cisco and/or its affiliates. All rights reserved.CiscoConfidential
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Resolved Caveats (1)

DDTS ID タイトル Se verity 製品

機能 /

コンポーネント ステー タス

Cisco TelePresence Video Communication Server

CSCvr42832
Stop sharing option does not work during 

Proximity Sharing from Touch 10 of MX200 G2
2 tc-software gui-sharing R-Resolved

CSCvr46850
DN of holding endpoint is not visible to user in 

OSD of SX20 Quick Set
2 tc-software gui-incall R-Resolved

CSCvr29430

Unable to re-edit the DNS Domain Name once 

after setting in SX10 Quick Set via Remote 

Control

3 tc-software gui-setupdiag R-Resolved

Cisco Jabber Clients

CSCvr01996
Font color is not displaying in high contrast mode 

of Cisco Jabber for Windows
3 jabber-

windows
Accessibility R-Resolved

CSCvr70692
Unable to move to different flag messages under 

same user in JTMM for Windows
3 jabber-

windows
im-presence R-Resolved
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Resolved Caveats (2)

DDTS ID タイトル Se verity 製品

機能 /

コンポーネント ステー タス

CSCvr31339
Notification is sending for two times for screen 

shot alone in Cisco Jabber for android
3 umc-android instantmessage R-Resolved

CSCvs73534
Unable to join meeting using meeting number 

from Cisco Jabber for Windows
3

jabber-

windows
docs R-Resolved

CSCvs74248
Unable to join Cisco Webex Meetings from 

Jabber for Mac using meeting number
3

jabber-

mac
documentation R-Resolved

Cisco Webex Meetings

CSCvs75792
Nothing be shared when used Share This File -> 

Share to Meeting from Word to share PD file
3 train pt V-Verified
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Resolved Caveats (3)

DDTS ID タイトル Se verity 製品

機能 /

コンポーネント ステー タス

Cisco Webex Room OS

CSCvr51008
T10 stage view not properly updated after adding 

to call
2 tc-software gui-home R-Resolved

CSCvs35858

Device added to Webex call displays name of 

adder as meeting title and not "Webex team 

meeting"

2 tc-software gui-incall R-Resolved

CSCvs61175
'is busy' string in Webex Room Devices 

translation is incorrect in Japanese
3 tc-software translation R-Resolved



Cisco Webex Room OSOpen Caveats



Cisco Webex Room OSCisco TelePresence Video Communication Server



CSCvs42919:Keyboard “Enter” key should be highlight during ethernet setting in Webex Room Kit Plus (O-Opened 
/Sev-2/Global)

Issue Description: 
Check whether keyboard “Enter” key highlight during Ethernet setting of Cisco 
Webex Room Kit Plus while registration into Cisco Unified Communications 
Manager under Japanese Environment

Environment Matrix:
• Unified CM Build - 12.5.1.12900-104
• Webex Room Kit Plus Build - ce 9.10.0 8482b3d0775 2019-12-04

Steps to Reproduce:
1. Factory reset Webex Room Kit Plus
2. Tap on Ether net setting ->Tap on DNS Domain Name

Actual Behavior:
Enter key is not highlighted in keyboard during configure Ethernet setting of Webex 
Room Kit

Expected Behavior:
During Ethernet setting page “Enter” key should be highlighted

Global

© 2020 Cisco and/or its affiliates. All rights reserved. Cisco Confidential

In JP Environment 



CSCvr46860: Name of the endpoint is changing automatically during edit and call from SX20 Quick Set (O-Opened 
/Sev-3/Global)

Issue Description: 
During edit and call functionality from SX20 Quick Set name of the endpoint 
alters automatically

Environment Matrix:
• Unified CM Build - 12.5.1.12900-47
• SX20 Quick Set Build - ce 9.9.0 ecb7a8f782b 2019-09-13

Steps to Reproduce:
1. Register SX20 Quick Set in Unified CM
2. Access SX20 Quick Set using TRC 6 
3. Go to recents in OSD of SX20 Quick Set and select edit and call option
4. Select same contact listed down in recents tab by using arrow down keys 

from TRC 6
5. Then select ok button from TRC 6 check the name of the endpoint

Actual Behavior:
Name of the endpoint is changing automatically after clicking on OK button 
from TRC 6

Expected Behavior:
Name of the endpoint should not change after clicking on OK button

Global

© 2020 Cisco and/or its affiliates. All rights reserved. Cisco Confidential

In JP Environment 



CSCvr60313: Participant(s) in stageview still clickable when covered by full-screen selfview(O-Opened/Sev-3/Global)

Issue Description: 
Self-view and avatar both able to see by user after maximizing the self-view in Touch 10 of 
Webex Room Kit

Environment Matrix:
• Unified CM Build - 12.5.1.12900-47
• Webex Room Kit Build - ce 9.9.0 ddbf68ad0e2 2019-09-26
• Webex Room Kit Plus PTZ Build - ce 9.9.0 ddbf68ad0e2 2019-09-26

Steps to Reproduce:
1. Register Webex Room Kit and Webex Room Kit Plus PTZ in Unified CM
2. Make a call from Webex Room Kit to Webex Room Kit Plus PTZ
3. Maximize the self-view using Touch 10 of Webex Room Kit
4. Tap anywhere in Touch 10 of Webex Room Kit 
5. User can able to see details of avatar and self-view options 

Actual Behavior:
User gets avatar details after maximizing self-view in Touch 10

Expected Behavior:
User should not get avatar details after maximizing self-view in Touch 10

Global
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In JP Environment 



CSCvr60327: Web UI redirects back to signin page with white background if "next" parameter is /web/signin/random (O-
Opened/Sev-3/Global)

Issue Description: 
Self-view and avatar both able to see by user after maximizing the self-view in 
Touch 10 of Webex Room Kit

Environment Matrix:
• Unified CM Build - 12.5.1.12900-47
• Webex Room Kit Plus PTZ Build - ce 9.9.0 ddbf68ad0e2 2019-09-26

Steps to Reproduce:
1. Register Webex Room Kit Plus PTZ in Unified CM
2. Open Web UI of Webex Room Kit Plus PTZ using URL. After “sign in” provide 

some random characters. Ex :” https://PTZIPAddress/web/signin/random”
3. Login using credentials and check the web UI of Webex Room Kit Plus PTZ

Actual Behavior:
Login Page of Webex Room Kit Plus PTZ becomes white background after 
entering random url

Expected Behavior:
Login Page of Webex Room Kit Plus PTZ should not display white background

© 2020 Cisco and/or its affiliates. All rights reserved. Cisco Confidential

Global

In EN Environment 

https://ptzipaddress/web/signin/random


CSCvr61379: During call hold, DN label is highlighted in OSD of SX20 Quick Set (O-Opened/Sev-3/Global)

Issue Description: 
During call hold, DN label is highlighted in OSD of SX20 Quick Set while in a call with Webex 
Room Kit Plus PTZ accessing via TRC 6

Environment Matrix:
• Unified CM Build - 12.5.1.12900-47
• Webex Room Kit Plus PTZ Build - ce 9.9.0 ddbf68ad0e2 2019-09-26
• SX20 Quick Set Build - ce 9.9.0 ddbf68ad0e2 2019-09-26

Steps to Reproduce:
1. Register SX20 Quick Set and Webex Room Kit Plus PTZ in Unified CM
2. Control SX20 via TRC 6
3. Make call from SX20 Quick Set to Webex Room Kit Plus PTZ
4. Hold call from SX20 Quick Set using TRC 6
5. By using arrow keys try to move cursor to top middle 
6. User can able to see highlighted option for DN label

Actual Behavior:
DN label highlight is visible at the top middle of the screen

Expected Behavior:
DN label highlight should not visible in top middle of the screen

© 2020 Cisco and/or its affiliates. All rights reserved. Cisco Confidential

Global

In JP Environment 



CSCvs62346: Remote control OSD fades out when opening layout list/participant list when having fullscreen selfview   
(O-Opened/Sev-3/Global)

Issue Description: 
Check whether participant list highlighting over self-view maximized screen in 
Cisco TelePresence SX10 Quick Set during call with Cisco Webex DX70 all 
registration into Cisco Unified Communications Manager under Japanese 
Environment
Environment Matrix:
• Unified CM Build - 12.5.1.12900-108
• Webex DX70 Build - ce 9.10.0 0a25d810acf 2019-12-09
• SX10 Quick Set Build - ce 9.10.0 0a25d810acf 2019-12-09
Steps to Reproduce:
1. Register Webex DX70 and SX10 Quick Set in Unified CM
2. Make call from SX10 Quick Set to Webex DX70
3. Accept call from Webex DX70
4. Navigate on OSD as Camera icon -> Turn on Self-View -> Click on Maximize 

self-view through remote of SX10 Quick Set
5. Click back button through remote of SX10 Quick Set
6. Check Participant list by participant list option on OSD of SX10 Quick Set
Actual Behavior:
Participant list highlighted over self-view maximized screen in SX10 Quick Set 
while in call with Webex DX70
Expected Behavior:
Participant list should not highlight over self-view maximized screen in SX10 
Quick Set© 2020 Cisco and/or its affiliates. All rights reserved. Cisco Confidential

Global

In JP Environment 



CSCvr50804 :Show passphrase available in English while registering into VCS from Webex DX70 under Japanese 
Environment (O-Opened/Sev-3/Regional)

Issue Description: 
Check whether “Show passphrase” available in English while registering into Cisco Video 
Communication Server from Cisco Webex DX70 under Japanese Environment

Environment Matrix:
• Unified CM Build - 12.5.1.12900-16
• Cisco VCS Build - X12.6PreAlpha15
• Webex DX70 Build - ce 9.9.0 ddbf68ad0e2 2019-09-26

Steps to Reproduce:
1. Register Webex DX70 in Unified CM
2. Tap on DN -> Setting -> Device Activation -> Other-services -> VCS 

Actual Behavior:
“Show passphrase” available in English while registering into VCS from Webex DX70 under 
Japanese Environment

Expected Behavior:
“Show passphrase” should be in Japanese while registering into VCS from Webex DX70 

© 2020 Cisco and/or its affiliates. All rights reserved. Cisco Confidential

Regional

In EN Environment 

In JP Environment 



CSCvr60354:Add call option is not available in Proximity app while connected to Webex DX70 (O-Opened/Sev-3/Global)

Issue Description: 
Check whether add call option is available in proximity app while connected to Webex 
DX70 during the call with Cisco Webex Room Kit Plus Pan-Tilt-Zoom registered in Cisco 
Unified Communications Manager

Environment Matrix:
• Unified CM Build - 12.5.1.12900-16
• Webex DX70 Build - ce 9.9.0 ddbf68ad0e2 2019-09-26
• Webex Room Kit Plus PTZ Build - ce 9.9.0 ddbf68ad0e2 2019-09-26

Steps to Reproduce:
1. Register Webex DX70 and Webex Room Kit Plus PTZ in Unified CM
2. Connect Webex DX70 with proximity
3. Make call from Webex DX70 to Webex Codec PTZ

Actual Behavior:
Add call option is not available in Proximity app while connected to Webex DX70 

Expected Behavior:
Add call option should available in proximity app while connected to Webex DX70

© 2020 Cisco and/or its affiliates. All rights reserved. Cisco Confidential

Global

In EN Environment 



CSCvs52874: Overlap of Hold icon and Layout avatar during multisite conference in Touch 10 of MX200 (O-Opened/Sev-
3/Global)
Issue Description: 
During multisite conference, when holding the call from touch 10 of MX200 G2, overlap of Hold icon and layout 
avatar icon is observed
Environment Matrix:
• Unified CM Build - 12.5.1.12900-108
• SX10 Quick Set Build - ce 9.10.0 0a25d810acf 2019-12-09
• Webex DX70 Build - ce 9.10.0 0a25d810acf 2019-12-09
• MX200 G2 Build - ce 9.10.0 0a25d810acf 2019-12-09
• Cisco VCS Build - X12.6PreAlpha15
Steps to Reproduce:
1. Register SX10 Quick Set and Webex DX70 in Unified CM
2. Register MX200 G2 in Cisco VCS
3. Make video call from Webex DX70 to MX200 G2. Answer the call in MX200 G2
4. Make video call from SX10 Quick Set to MX200 G2
5. Keep the conference setting in MX200 G2 as multisite conference
6. From the Touch 10 of MX200 G2, turn on selfview.  Set the Layout as single
7. Tap on selfview contact card and tap on maximize. 
8. Tap on Hold icon from touch 10 of MX200 G2.
9. Overlap of hold icon and layout avatar is seen
Actual Behavior:
Overlap of hold icon and layout contact card avatar is overlapped during call hold from MX200 G2
Expected Behavior:
Hold icon and layout contact card avatar should not overlap each other

© 2020 Cisco and/or its affiliates. All rights reserved. Cisco Confidential

Global

In JP Environment 



Cisco Webex Room OSCisco TelePresence Server



CSCvr50559:Entering Wrong Credentials Event not included in Event Logs of TelePresence Server (N-New/Sev-2/Global)

Issue Description:
Entering Wrong Credentials Event not included in Event Logs of TelePresence Server

Environment Matrix:
• Cisco TelePresence Server - 4.4.(1.29)

Steps to Reproduce:
1. Login to Web UI of TelePresence Server
2. Click on Logout available in Web IO of TelePresence Server
3. Login with Invalid Credentials 
4. After TelePresence Server throws an Error
5. Now login with Valid Credentials
6. Go to Logs -> Event Logs
7. Check for Event of Invalid Credentials Trail 

Actual Behavior:
TelePresence Server should  show Event of invalid Credentials on the Event Logs

Expected Behavior:
Invalid Credentials Events are not getting captured in Event Logs 

© 2020 Cisco and/or its affiliates. All rights reserved. Cisco Confidential

Global



Cisco Webex Room OSCisco Webex Meetings



CSCvs38297: Webex Meetings username is displaying partially incorrect(N-New/Sev-3/Global)

Issue Description :
Full name of Cisco Webex Meetings user is not displaying correctly

Environment Matrix :
• Cisco Webex Meetings for Windows - 39.10.4.5
• Cisco Webex Meetings for Web - 39.10.1.11

Pre-Requisites:
• Install Webex Meetings application on Windows10
• Login with user1@cisco.com in Windows device
• Login in Web app with user2@cisco.com

Steps to Reproduce:
1. User1 starts the meeting and user2 joins the meeting by meeting id
2. User2 clicks on "participants" list to show the list of all participants in 

the ongoing meeting

Actual Behavior:
Username for user1 is displaying wrongly during the meeting

Expected behavior:
Username for user1 should be displayed with correct name

© 2020 Cisco and/or its affiliates. All rights reserved. Cisco Confidential

Global

In JP Environment 

mailto:user2@cisco.com


CSCvr39201:Become Presenter option is wrongly displayed when changing presenter role during Webex Meeting (A-
Assigned/Sev-3/Global)

Issue Description:
Become Presenter option is wrongly displayed when changing presenter role during 
Webex Meeting
Environment Matrix:
• Cisco Webex Meet for Mac - 39.7.3.3
• Cisco Webex Meet for Windows - 39.7.3.3
Pre-Requisites:
• Install Webex Meeting application on Mac and Windows
• Login with user1@cisco.com  and user2@cisco.com in Mac and Windows
• Initiate a Meeting from user 1 to user 2
• User 1 is the host and User 2 is the Participant
Steps to Reproduce:
1. From user 1 in Mac device click participant icon
2. Click the Webex ball icon near the Profile pic of the user 1 and drag the icon to user 2
3. A pop up appears, which states " Do you want to change the presenter to user 2?“
4. For the above question i get the options like "Become Presenter“
5. I don't why this option is coming as the perspective from user 2?
Actual Behavior:
The options "Become Presenter" is coming with the perspective from user 2. Similarly 
from user 1 when i am swaping the presenter role from user 2 to user 1 I am getting the 
option as "Become Presenter"which is been revelent to the user 1
Expected Behavior:
The option for changing the presenter role should be "Yes" or "No" which comes in for 
Cisco Webex Meeting for Windows.

© 2020 Cisco and/or its affiliates. All rights reserved. Cisco Confidential

Global

In EN Environment 



Cisco Webex Room OSResolved Caveats



Cisco Webex Room OSCisco TelePresence Video Communication Server



CSCvr42832:Stop sharing option does not work during Wireless Sharing from Touch 10 of MX200 G2 (R-Resolved 
/Sev-2/Global)

Issue Description: 
Tapping on “Stop Sharing” option in Share tray during Wireless sharing MX200 G2 paired with 
Windows via Cisco Proximity, does not stop the content from sharing

Environment Matrix:
• Unified CM Build - 12.5.1.12900-16
• MX200 G2 Build - ce 9.9.0 ecb7a8f782b 2019-09-13
• Webex DX70 Build - ce-9.9.0-08bf38247af-2019-08-28

Steps to Reproduce:
1. Register MX200 G2 and Webex DX70 in Unified CM
2. Pair Cisco Proximity for Windows with MX200 G2
3. Make video call from MX200 G2 to Webex DX70.  Answer the call in Webex DX70
4. Tap on Share from Windows via Proximity
5. Tap on Minimize from Touch 10 of MX200 G2
6. Tap on the “Share” tray from the Touch 10 and select “Stop Sharing”

Actual Behavior:
On tapping “Stop Sharing” option, the presentation sharing screen does not stop

Expected Behavior:
Tapping on “Stop Sharing” should stop the presentation from sharing
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CSCvr46850: DN of holding endpoint is not visible to user in OSD of SX20 Quick Set (R-Resolved/Sev-2/Global)

Issue Description: 
DN of holding endpoint is not visible in OSD of SX20 Quick Set while in a call with Webex Room Kit 
Plus PTZ

Environment Matrix:
• Unified CM Build - 12.5.1.12900-47
• SX20 Quick Set Build - ce 9.9.0 ecb7a8f782b 2019-09-13
• Webex Room Kit Plus PTZ Build - ce 9.9.0 ecb7a8f782b 2019-09-13

Steps to Reproduce:
1. Register Webex Room Kit Plus PTZ and SX20 Quick Set in Unified CM
2. Make a call from Webex Room Kit Plus PTZ to SX20 Quick Set
3. Hold the call from SX20 Quick Set
4. Check for the DN in OSD of SX20 Quick Set

Actual Behavior:
DN is not visible to user in OSD of SX20 Quick Set

Expected Behavior:
DN should be visible to user in OSD of SX20 Quick Set
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CSCvr29430:Unable to re-edit the DNS Domain Name once after setting in SX10 Quick Set via Remote Control(R-
Resolved/Sev-3/Global)

Issue Description: 
Keyboard Panel does not allow user to re-edit the DNS Domain Name setting 
using Remote Control of SX10 Quick Set

Environment Matrix:
• Unified CM Build - 12.5.1.12900-47
• SX10 Quick Set Build - ce-9.9.0-08bf38247af-2019-08-28

Steps to Reproduce:
1. Register SX10 Quick Set in Unified CM
2. Tap on Settings -> Network Connection -> Open Ethernet settings
3. DNS Domain Name -> Input the DNS name here using Remote Control
4. After setting, try to navigate and re-edit the DNS Domain name again

Actual Behavior:
Keyboard panel layout should be able to edit even though the DNS Domain 
Name is set already.  Should be able to re-edit the settings 

Expected Behavior:
Keyboard Panel layout gets froze/locked to edit the DNS Domain Name setting 
using Remote Control once it is set in first place
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CSCvr01996: Font colour is not displaying in high contrast mode of Cisco Jabber for Windows (R-Resolved/Sev-3 
/Global)

Issue Description: 
In high contrast mode font colour is not reflecting even after colour is changing

Environment Matrix:
• CUCM - 12.5.1.12900-47
• CUP - 12.5.1.12000-52
• CJW Version - 12.7.0(286792)

Steps to Reproduce:
1. Download and install Cisco Jabber in Windows 1
2. After successful installation login in to Jabber using valid credentials
3. Go to setting and change the appearance to "High Contrast Mode"
4. Now go to Contacts and select a contact to initiate a chat
5. Change the font colour from black to yellow
6. Now type a message in composition window and send a message

Actual Behavior:
Font colour is not displaying in high contrast mode of Cisco Jabber for Windows  

Expected Behavior:
Font colour should display in high contrast mode of Cisco Jabber for Windows 
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CSCvr70692: Unable to move to different flag messages under same user in JTMM for Windows (R-Resolved/Sev-3 
/Regional)

Issue Description: 
Unable to move switch between the flagged messages if may flagged messages are available 
under one user in flags drop down
Environment Matrix:
• CUCM - 12.5.1.12900-47
• CUP  - 12.5.1.12000-52
• CJW Version - 12.7.0.38632 Build 288632
Steps to Reproduce:
1. Download and install Cisco Jabber in Windows 1
2. After successful installation login in to Jabber using valid credentials
3. Select the user and send multiple messages to Cisco Jabber for Windows 2
4. From Cisco Jabber for Windows 2 flag the messages received from Cisco Jabber for 

Windows1
5. Go to Flag option
6. Click on the flagged messages
Actual Behavior:
Only first flagged messages can highlight the flagged messages and unable to highlight other 
flagged messages
Expected Behavior:
It should switch and highlight all the flagged messages when selected from flagged drop down
NOTE: if only one user messages are flagged, we cannot it cannot switch to all the flagged 
messages under flags drop down
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CSCvr31339: Notification is sending for two times for screen shot alone in Cisco Jabber for android(R-Resolved 
/Sev-3/Global)

Issue Description: 
While sending screen shot rom Cisco Jabber for Windows to Cisco Jabber for Android, Cisco 
Jabber for Android is receiving notification for two times

Environment Matrix:
• Cisco Jabber for Windows - 12.7.0.38632 Build 288632
• Cisco Jabber for Android - 12.7.0.288625
• Android device - Nexus 6P

Steps to Reproduce:
1. Download and install Cisco Jabber in Windows and Cisco Jabber for Android 
2. After successful installation login in to Jabber using valid credentials
3. Now from Cisco Jabber for Windows go to chat icon and search for contact to send a 

screen shot
4. Select a contact(Cisco Jabber for Android) to send a screen shot
5. Cisco Jabber for Android will receive a notification 

Actual Behavior:
Notification is sending for two times for screen shot alone in Cisco Jabber for android

Expected Behavior:
Notification should send only for one time for screen shot in Cisco Jabber for android
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CSCvs73534: Unable to join meeting using meeting number from Cisco Jabber for Windows (R-Resolved/Sev-3/Global)

Issue Description:
User is unable to join Webex meetings from Cisco Jabber for Windows using meeting number

Environment Matrix:
• Cisco Jabber for Windows - 12.8.0.51920 Build 301920
• Cisco Webex Meetings for Windows - 39.11.2.4

Pre-Requisites:
• Install Jabber version 12.7 or above for Windows
• Install Cisco Webex Meetings for Windows
• Install Cisco Webex Productivity tool

Steps to Reproduce:
1. Login to Cisco Webex Meetings and Cisco Jabber for Windows with user1@domain.com
2. User2 starts meetings in Cisco Webex Meetings for desktop/Mobile
3. Under "Calendar" icon, provide user2's meeting number only in Cisco Jabber for user1
4. Click "Join" to join user2's meeting

Actual Behavior:
User of Cisco Jabber for Windows is unable to join the meeting using meeting number of host

Expected Behavior:
User should be able to join meeting using host's meeting number from Cisco Jabber for Windows

© 2020 Cisco and/or its affiliates. All rights reserved. Cisco Confidential

Global

In JP Environment 

mailto:user1@domain.com


CSCvs74248: Unable to join Cisco Webex Meetings from Jabber for Mac using meeting number (R-Resolved/Sev-3 
/Global)

Issue Description:
Jabber for Mac user is unable to join Webex Meetings using meeting number of the 
host
Environment Matrix:
• Cisco Jabber for Mac - 12.8.0(301920)
• Cisco Webex Meetings for Mac - 39.11.2.4
Pre-Requisites:
• Install Jabber version 12.7 or above for Mac
• Install Cisco Webex Meetings for Mac
• Install Cisco Webex Productivity tool
Steps to Reproduce:
1. Login to Cisco Webex Meetings and Cisco Jabber for Mac with 

user1@domain.com
2. User2 starts meetings in Cisco Webex Meetings for desktop/Mobile
3. User1 tries to join user'2 meeting using meeting number of the host (user2) from 

"Calendar" -> "Join a Meeting" -> "Join“
Actual Behavior:
User of Cisco Jabber for Mac is unable to join the Webex meeting using meeting 
number of host
Expected Behavior:
User should be able to join Webex meetings using host's meeting number from Cisco 
Jabber for Mac
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CSCvs75792: Nothing be shared when used Share This File -> Share to Meeting from Word to share PD file (V-Verified 
/Sev-3/Global)

Issue Description :
Unable to share documents in Webex Meeting by using “Share This File” option in Microsoft 
Documents (Excel/Word/PPT)
Environment Matrix :
• Cisco Webex Meetings for Windows - 39.11.2.4
Pre-Requisites:
• Install Cisco Webex Meetings for desktop (Mac/Windows)
• Install MS Office 365
• Install Cisco Webex Productivity Tools
Steps to Reproduce:
1. Login to Cisco Webex Meetings for Windows/Mac
2. Start Webex meeting
3. Open an MS document (Excel/PPT/Word)
4. Click “Share this File” -> “Share to Meeting”
Actual Behavior:
Microsoft document (Excel/Word/PPT) is not seen in Webex meetings when
sharing from document itself
Expected Behavior:
Microsoft document (Excel/Word/PPT) is should be visible in Webex meetings when sharing 
from document itself
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CSCvr51008:T10 stage view not properly updated after adding to call (R-Resolved/Sev-2/Global)

Issue Description: 
String is overlapping after connected to call of Webex Teams for Windows when wireless 
sharing is about to start from Webex Teams for iOS in Webex Room Kit Plus PTZ. Wireless 
sharing is stopped after connecting to incoming call, but string is overlapping and incorrect 

Environment Matrix:
• Webex Room Kit Plus PTZ - RoomOS 2019-09-12 ee4956daae7
• Webex Teams for Windows - 3.0.13464.0
• Webex Teams for iOS - 4.6 (62)
Steps to Reproduce:
1. Register Webex Room Kit Plus PTZ to Webex Cloud
2. Login to Webex Teams for iOS and Windows using Webex user credentials
3. Pair Webex Teams for iOS to Webex Room Kit Plus PTZ
4. Start Wireless sharing from Webex Teams for iOS (about to start sharing)
5. Make call from Webex Teams for Windows to Webex Room Kit Plus PTZ(Sharing                      

and call at a time)
6. Answer the call in Webex Room Kit Plus PTZ
7. Check string is overlapping after answering incoming call
Actual Behavior:
String is overlapping after connected to call during Wireless sharing in Room Devices
Expected Behavior:
String should not be overlapped after connected to call during Wireless sharing in Room 
Devices
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CSCvs35858:Device added to Webex call displays name of adder as meeting title and not "Webex team meeting“     
(R-Resolved/Sev-2/Global)

Issue Description:
Webex meeting details are not displayed in Touch 10 of Webex Room Device (MX200 G2) 
during Webex meeting with Webex Room Kit Plus PTZ (Pan Tilt Zoom) and Webex Room 
Device (SX80 Codec)
Environment Matrix: 
• Webex Room Device (MX200 G2) - RoomOS 2019-11-25 d77823b4a64
• Webex Room Device (SX80 Codec) - RoomOS 2019-11-25 d77823b4a64
• Webex Room Kit Plus PTZ - RoomOS 2019-11-25 d77823b4a64
Steps to Reproduce:
1. Register MX200 G2, SX80 Codec and Webex Room Kit Plus PTZ to Webex Cloud 
2. Make a call from Webex Room Kit Plus PTZ to Webex Room Device (SX80 Codec)
3. Answer the call in Webex Room Device (SX80 Codec)
4. Add Webex Room Device (MX200 G2) from Webex Room Kit Plus PTZ
5. Check the Touch 10 of Webex Room Device (MX200 G2)
Actual Behavior:
Webex meeting details are not displayed in MX200 G2 after adding call from Webex Room 
Kit Plus PTZ
Expected Behavior:
Webex meeting details should be displayed in MX200 G2 after adding call from Webex 
Room Kit Plus PTZ
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CSCvs61175: ‘is busy’ string in Webex Room Devices translation is incorrect in Japanese(R-Resolved/ Sev-3/Regional)

Issue Description: 
‘is busy’ string in Webex Room Device (MX200 G2) translation is incorrect in 
Japanese when call is declined from Webex Room Device (SX80 Codec)

Environment Matrix:
• Webex Room Device (MX200 G2) - RoomOS 2019-12-16 285a7f8edd1
• Webex Room Device (SX80 Codec) - RoomOS 2019-12-16 285a7f8edd1

Steps to Reproduce:
1. Register MX200 G2 and SX80 Codec to Webex Cloud
2. Set language as ‘Japanese’ in Webex Room Device (MX200 G2)
3. Make call from Webex Room Device (MX200 G2) to Webex Room Device 

(SX80 Codec)
4. Decline the call in Webex Room Device (SX80 Codec)
5. Check ‘is busy’ string in Webex Room Device (MX200 G2) in Japanese

Actual Behavior:
‘is busy’ string in Webex Room Devices translation is incorrect in Japanese

Expected Behavior:
‘is busy’ string in Webex Room Devices translation should be correct in Japanese
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